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Home Manager User Guide

Welcome

4T

Welcome to the Home Manager User Guide

If you have just started using Home Manager, check out the Introduction and Getting Started links below.
More details can be found in the Reference and How To section.

> Introduction

Getting Started
> Reference

» How To (Steps)
Introduction

Home Manager is an easy-to-use database for tracking information about your home and personal
belongings. Home Manager provides a central repository for storing and retrieving your Home records,
allowing you to quickly look up information about a specific item at any time. A free trial version is
available on our website and can be set up in minutes so you can try the full functionality of the software.

What It's For

Do you need a way to track all of your "stuff"? With Home Manager you can organize and track your
home inventory. Easily enter the details about your belongings, and use the built-in search feature to find
it again quickly. If you already have a lot of digital pictures, simply drag and drop them into the program
to automatically create new inventory items for each one.

Organize your inventory by category and location, and drag and drop items from one category to
another. Keep a running maintenance and repair history for your assets. Print a home inventory report
(complete with digital pictures) for your insurance agent; backup your data for safekeeping, and get the
peace of mind that comes with having a full accounting of your home inventory.

Home Manager Helps You Get Organized

You have better things to do with your time than searching through paperwork or digging through old
paint cans looking for that lost color code. Now you can stop the frustrating searching and take control.
With Home Manager software you can have all the information you need about your home right at your
fingertips.

Be Prepared For The Unexpected

Sadly, every year natural disasters like earthquakes, fires, floods, tornadoes and hurricanes leave people
without @ home and with their possessions lost or destroyed. Without a detailed record, making an
insurance claim can be a hassle at best. Whether you own your home, or rent an apartment, insurance
companies recommend that you keep a current home inventory record to assist in the event of an
insurance claim. Home Manager gets you started by building a complete home inventory. You can track
warranty and insurance information, and even include digital pictures to assist in the unfortunate event of
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Introduction 3

an insurance claim. Use the built-in backup feature to backup to a remote drive or email server

Features at a Glance

v"Home Inventory Tracking for one or multiple residences.

v’ Track costs for home improvement and repair.

v' Store your book and movie information in a database.

v Track warranty and insurance Information.

v Import an unlimited number of digital pictures.

v' Search your inventory to find records fast.

v’ Backup your inventory to disk, floppy, or as an Email Attachment.
v Print report for off-site storage.

v’ Create your own custom categories and locations.

Home Manager Licensing

e Home Manager licenses may be purchased online with a credit card, bank transfer, or a check. The
license key is delivered via email and unlocks the 10 record limitation of the trial.

e Home Manager licenses include free minor upgrades for the life of the version and major upgrades for
one year. Upgrading is voluntary and not required to continue using the version of the software that
has been purchased.

e Support by email is available free for both trial and licensed users (see additional support information
in the next section).

Product Number of users Price (USD)*

Home Manager Standard Edition Single User PC $29.99

*Prices in EUR and other currencies based on the exchange rate at the time of purchase.

Home Manager Support

All Home Manager support is available free by email. Additional paid support by telephone is not available
at this time. This support model allows our customers around the globe to reach an appropriate expert
for their specific technical, sales, or customer service question without wading through multiple levels of
support and call backs. Support tickets may be submitted through the website at www.kzsoftware.com

See Also

» Getting Started
> Reference

21 Getting Started
Choose from the following topics to get started:

> Installation
> Enter your license key

Or for experienced users, jump to the Reference section.

© 2024 Kaizen Software Solutions
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Installation
To install from the web:

1. Download Home Manager from the website at:

http: //www.kzsoftware.com/products/home-inventory-software/demo.htm
2. Open/Run the setup file, HomeManagerSetup.exe.
3. Follow the instructions in the installation wizard to complete the installation.

Welcome to the Home Manager
Setup Wizard

“This wil install Home Manager 2010 on your compuer

tis recomment ded that you close all cther applications before
continuing

Ciick Next to Gontinue, or Cancel to exit Setup.

—

.

5 Setup - Home Manager

License Agreement

Please resd the following License Agreemert. You must accept the tems of this
agreement before continuing with the instalation

[LICENSE AGREEMENT

1.  Grant of License. This is a legal
Agreement between you and Kaizen Software
Soluticns. The terms of this Agreement govern
your use of this program. By requesting this
Iprogran, you are agreeing to be bound by this
[Agreement. If you do not agree to the terms of -

© Tscapi s st
| do not accept the agreement

<Basck Cancel

5] Setup - Home Manager —- = o

Select Destination ion
Where should Home Manager be installed?

Setup wil install Home Manager nto the following foider

To continue, click Next.  you would lice to sslect a diferert folder, click Browse.

Bowee

C:\Program Files (86]\Home Maniager 2010

Atleast 24.8 VB of free disk space s required

<Bsck Cancel

Open/Run the setup file to
begin the Setup Wizard, and
then click the Next button.

Read the license agreement,
and then select "I accept the
agreement” before clicking the
Next button to continue.

You may leave the default
installation location selected, or
select a different location if
needed.

5! Setup - Home Manager

T =
Select Start Menu Folder

Where should Setup place the program’s shottouis?

J  Selup wil create the programis shortcuts inthe folowing Statt Menu folder.

To continue, cick Next.  you would i to select a dfferert folder, cick Browse.

Browse.

fome Manage:]

<Back Cancel

5! Setup - Home Manager

T =i
Select Additional Tasks

Which addtional tasks should be performed?
Select the addiional tasks you would ke Setup to perform while instaling Home:
Manager,then click Neat.

Addtional icons:
) Erots o

<Back Cancel

Ciick Install o cortinue with the installation, or lick Back f you wart to review or
change any seftings

Destination location:
C:\Program Fies 86)\Home Manager 2010

A shortcut will be created in the
Start Menu Folder. Click the
Next button to continue.

T

Completing the Home Manager
Setup Wizard

5! Setup - Home Manager

Setup has firished instaling Home Manager on your computer
e application may be launched by selecting the installed
Click Finish to exit Setup.

] {aunch Fome Managert

Click the Finish button and wait
a few moments as the software
initializes the first time.

Leave the checkbox checked to
create a desktop icon. Click the
Next button to continue.

Also note: if your computer
does not have the .NET2
framework installed already,
the installer will automatically
download and install it before
continuing.

Click the Install button to begin
the installation.
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Introduction 5

21.2 Enteryourlicense key

After purchasing a license key, you will need to enter it into the software to unlock the 10 record
limitation imposed while in Trial mode.

1. Select the menu item Help > Enter License Key (note: the menu items are the "text" links at the
top of the window - not to be confused with the "buttons" in the toolbar).

2. Enter your license key into the License Key form.

3. Press the enter key or click the Ok button to save.

License Key

p Home Manager

Enter your license key below:

License Key Form
Note: The button will remain disabled if the key is invalid.

2.2 Reference

The Reference section provides a detailed explanation of each area of Home Manager. Click on a link
below for details about the item.

e Menu Bar
o File
o Help

¢ Inventory
o General

o Maintenance and Repair
o Warranty and Insurance
o File Attachments

o Notes

e Reports

221 Menu Bar

The menu bar is located at the top of the main window. Click on any of the menu items listed below for
more information.

Menu Bar Items

© 2024 Kaizen Software Solutions
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> File
> Help

2.2.1.1 File Menu

The Fle menu contains the menu items listed below. Click on a link below for complete details.

File Menu Items

> Backup
> Restore

> Exit

2.2.1.1.1 Backup

The Backup function creates a compressed data file containing a full backup of the database. This feature
allows you to create a backup manually at any time.

Home Manager

Backup database

Select a location for the backup file:

Chlsers\AdminiDocurnentsiHome Manager Browse...
“Backup_110104_145515.hbk

@ Backup Cancel

Backup Database Dialog

Steps to backup a database

1. Select Ale > Backup to open the Backup database dialog box.

2. Click the Browse button to select a location for the file, and enter the name of the file to save.

3. Click the "Backup" button to perform the backup.

4. Dismiss the confirmation box. If the Backup operation fails for any reason, close the application and
then reopen it and perform the Backup operation again.

© 2024 Kaizen Software Solutions
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. ="\

Backup file created

h —I_'J
Confirmation Dialog

Key Points:

<+ The backup file is a compressed snapshot of the database. It cannot be opened directly. To restore the
database from the backup file, use the menu option: Fle > Restore.

+ Be sure to store the backup file on an external or remote drive so it will be available in case your hard
drive crashes and becomes inaccessible. If possible, copy the file to a network server that is backed
up. You can also attach the file to an email that you send to yourself in order to have it saved on your
email server.

2.2.1.1.2 Restore

The Restore function restores the data from a compressed backup file over an existing database. This
operation will completely overwrite the current database with the contents of the backup file.

Home Manager

Restore from backup file

Select the backup file:

C:AUsers’Admin*DocumertsHome ManagerBackup_1 Browse..,

@ Restore Cancel

Restore Database Dialog

Steps to restore a database

. Select File > Restore to open the Restore database dialog box.

. Click the Browse button and select a backup file that you have created earlier.

. Click the Restore button and click "Yes" when asked if you want to proceed.

. Wait while the database is restored. This may take several minutes for a large database. Do not
interrupt the Restore operation, or the restored database may be corrupt.

5. Dismiss the confirmation box. If the restore operation fails for any reason, close the application and

then reopen it and perform the Restore operation again.

DN WNH=
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8 Home Manager User Guide

' ™

Restore succeeded. Restart Home Manager to reconnect to the database.

L T T _ —

Confirmation

Key Points

« The restore process may take several minutes to complete, and it should not be interrupted.

<+ The restore process will completely overwrite the database with the contents of the backup file. Any
data entered since the backup file was created will be overwritten.

2.21.1.3 Exit

Select Fle > Exit to close the application. This has the same effect as clicking the 'X' in the upper right
corner.

2.21.2 Help

The Help menu contains the menu items listed below. Click a link below for complete details.

Help Menu Items

> Check for updates
> Ask a question/Send feedback
> About Home Manager

2.2.1.2.1 Check for updates

The Check for updates menu initiates a connection to our update server to compare the version of the
software you are using with the current version of the software. A pop-up message will notify you to let
you know whether you are using the current version of the software. If you are using an older version,
you will be provided with an option to download the update. To install the update, download the setup
file when prompted, and click Open or Run to update your software. Your database will remain intact, so
you will not lose the data that has been previously entered.

If a firewall prevents you from connecting to our update server, you may also download the software
from the downloads page on our website. This is the same software which can be downloaded through
the Check for updates menu.

2.2.1.2.2 Ask a question

The menu option Ask a question / Send feedback will open a dialog box you can use to contact
Support. You may use this form to contact us about:

e Question

e Enhancement Request
¢ Bug Report

¢ Other Feedback

© 2024 Kaizen Software Solutions
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C% Please send us your feedback.

(Questions?, Problem?, Other Feedback?

\wle value your feedback as we strive to continuously improve this software. Please use this form to
send us questions, report a problem, submit an enhancement request, or provide any other feedback
you may have about this software.

Email Address: |

Category: [Que stion -

Mes=age:

Send Cancel

Feedback Form

2.2.1.2.3 About Home Manager

The About Home Manager menu item opens a dialog box with information about the currently installed
Home Manager software, including the version number.

2.2.2 Residence

The Residence screen contains general information about your residence including:

Address Details
Features
Mortgage
Insurance
Appraisals
Home Warranty

© 2024 Kaizen Software Solutions



10 Home Manager User Guide

i Home Manager

Eile  View Help

ﬁResidence @}In\rentory \jReports @Help

] New File [ Save

Address Specifications

- [123 Dak Street
Street Address: | | Year built: 201
city: [Anytown | interior Area: [2100
State: |California | Lot Area: 12000
Postal Code: (30210 |

Features |I'u'|0rtgage I Insurance |ﬁppraisals | Home Warranty|

Bedrooms:
Bathrooms:
e

Notes:

Residence Screen

After filling in the desired information, click the "Save" button to save the changes.

2.2.3 Inventory

The Inventory screen contains the Search Box, Category/Location list, Inventory List View, Picture Box,
and Data Entry tabs.

© 2024 Kaizen Software Solutions
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i Home Manager

Eile  View Help

ﬁ Residence @In\rentory DREports @ Help

| ,_)| Description Category
Filter by:
ICategory vl
Edit Categories...
Appliances
Automobiles
Books
CDs/DVDs
Clothing
Electronics
Furnishings [ ed P oeete @ 0oto
Jewelry
Miscellaneous & ceneral |% Maintenance/Repair History | ["] warrantyinsurance |@ File Attachments | ksl Notes|
] New inventory item | [ Save
Description: | | Location: m
Brand: Purchase date: 1 42011 @~
Model: Purchase Price: | |
Serial #: | | Current Value: | |
Condition: [Ngw .] Replacement Value: | |
Status: [In Use ,]

See Also

Inventory Screen

> General

» Maintenance and Repair
» Warranty and Insurance
> File Attachments

> Notes

General

The General tab on the Homes form is used to track additional information about the Home.

© 2024 Kaizen Software Solutions
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@ General |% Maintenance/Repair History | D Warranty/lnsurance |@ File Attachments | ] Notes|
_’| Mew inventory item E Save
Description: | | Location: [ Garage - I
Category: [Appliances ,] Purchased at: | |
Brand: | | Purchase date: 10 42011 e
Model: | | Purchase Price: | |
Serial #: | | Current Value: | |
Condition: [New vl Replacement Value: | |
Status: [In Use ,I
General tab
Fields and Form Elements
Feld or form element Description

Description A text field to track the Description of the item. The
description is displayed in the inventory list view
and reports.

Category A selection field to identify the Category of the
item. Add, edit, or delete the Category values by
clicking on the "+" button located to the right of the
field.

Brand A text field to track the Brand of the item.

Model A text field to track the Model of the item.

Serial # A text field to track the Serial # of the item.

Condition A selection field to identify the Condition of the
item.

Status A selection field to identify the Status of the item.

Location A selection field to identify the Location of the item.

Add, edit, or delete the Location values by clicking
on the "+" button located to the right of the field.

Purchased at

A text field to track the name of the store where
the item was purchased.

Purchase date

A date field to track when the item was purchased.

Purchase Price

A numeric field to track the purchase price of the

item.

Current Value A numeric field to track the current value of the
item.

Replacement Value A numeric field to track the Replacement Value for
the item.

See Also

» Maintenance and Repair

© 2024 Kaizen Software Solutions
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» Warranty and Insurance
> File Attachments

> Notes
2.2.3.2 Maintenance and Repair

The Service tab contains a list of the service (maintenance, inspection, or repair) that has been
completed for the Home.

& General %< Waintenance/Repair History |D Warrantylnsurance |@ File Attachments | el Nntes|

::_].ﬂ'«dd Repair | X Delete Repair

Date Summary Material Cost  Labor Cost

Maintenance/Repair Tab

Click the New Service Entry button to add a new completed service entry, or to schedule service to be
performed.

For completed service, fill in the Completed Date on the service entry form.

For Scheduled service, fill in the Next Due date on the service entry form.

Fill in both dates to indicate the service has been completed and to reschedule it for future service.

© 2024 Kaizen Software Solutions



14 Home Manager User Guide

Repair Item Form

P ’;. Add or edit repair details for the selected item.

Date of problem: V7M. @3
Date of repair: W02 @
Summary of problem: | | eaky roof b
Service Summary: Replaced asphalt shingles T

Material Cost: 4000
Labor Cost: 1500

| OK Cancel
Maintenance/Repair Entry form

Feld Name Description

Date of problem A date field to track when the problem was first
discovered.

Date of repair A date field to track when the maintenance/repair
was completed.

Summary of problem A text field to provide a short summary of the
problem.

Service Summary A text field to provide a short summary of the
service.

Material Cost A numeric field to track the material cost of the
maintenance/repair.

Labor Cost A numeric field to track the labor cost of the
maintenance/repair.

See Also

> General

» Warranty and Insurance
> File Attachments

» Notes

2.2.3.3 Warranty and Insurance

The Finance tab includes additional fields for tracking Finance related information.

© 2024 Kaizen Software Solutions
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|@ General |% Maintenance!RepairHistoryE'D Warrantylnsurance |@ File Attachments | e | Notes|

79 New inventory item [ Save

Manufacturer Phone:
Manufacturer Website:
Warranty Expiration Date:

Warranty Information:

@

1 420N

Dv

Fields

Warranty/Insurance Tab

Feld Name

Description

Manufacturer Phone

A text field for tracking the manufacturer's phone
number.

Manufacturer Website

A text field for tracking the manufacturer's website
address. Click the Globe icon to open the website in
a web browser.

Warranty Expiration Date

A date field to track the warranty expiration date.

Warranty information

A text field to track additional warranty/insurance
information.

See Also

> General
» Maintenance and Repair

> File Attachments
> Notes

2.2.3.4 File Attachments

The File Attachments tab contains an area where files may be added to the database.

© 2024 Kaizen Software Solutions




16 Home Manager User Guide

|@ General | ¢ Maintenance/Repair History | = WErrantyﬂnsurance| i File Attachments | e | Nutes|
&= e R

File Attachments Tab

See Also

> General

» Maintenance and Repair

» Warranty and Insurance
> Notes

2.2.3.5 Notes

The Notes tab contains a text field where free form text Notes may be added.

| & General | ¢ maintenanceiRepair History [ [ ] warrantyinsurance | @ File Attachments | ] Notes |
"l:] Mew inventory item E Save

Additional Notes:

Notes Tab

See Also

» General

» Maintenance and Repair
» Warranty and Insurance
» File Attachments

224 Reports

Home Manager comes with 3 built-in reports which can be viewed on-screen, printed, or saved as a file.

© 2024 Kaizen Software Solutions
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wi Home Manager -

Eile  View Help
{;%Residence @)In\rentory :Reports @Help

Select a report

Inventory Report itext only)

Inventory Report (with one picture)

Inventory Report (with multiple pictures)

Report Options

Group By: | Category -
Sort By: Description -

Filter: | Category - | =

L L* -

Reports Screen

e Click on a report link to open it in a new window.
e Standard filters, grouping, and sorting options are available on the report screen.

3 System Information

> File Locations

> Updating The Software
» Technical Details

3.1 File Locations

Below is a listing of default file locations for Config, Database, and Log files for our software products.
This information may be useful for special configurations or when diagnosing a connection error. In most
cases you will not need to modify these files. If you decide to modify any of the files listed below, create
a backup copy of the original file before changing it.

Config Files

File Name Location Description

[Program Name].exe.config Program Files\[Program Name] | This file contains the default
values that will be used to create

© 2024 Kaizen Software Solutions



18 Home Manager User Guide
the initial user.config file which in
turn is used to store individual
user preferences.
user.config Local Users Application Data This file is created the first time a
folder* specific user opens the program,
and it is updated as preferences
are changed
Database Files
File Name Location Description
[Program Name].hdb All Users Application Data folder* |This is the raw Firebird database
(on the client) file used by the embedded client.
Log Files
File Name Location Description
log.txt All Users Application Data folder* | This file contains the log of any
(on the client) application errors that occur on
the client.
*System Defined Folders
Local Users Application Data Folder:
The location of this folder varies according to the operating system:
e Windows Windows 7, 8, and 10: C:\Users\[user account name]
\AppData\Local\Kaizen_Software_Solutions\[Unique Program ID]
You may also find this folder by typing %USERPROFILE% in the "Search" box and then drilling down into
the appropriate folder.
All Users Application Data Folder:
The location of this folder varies according to the operating system:
e Windows Vista: C:\ProgramData\[Program Name]\[database file]
You may also find this folder by typing %AllUsersProfile% in the "Search" box and then drilling down into
the appropriate folder.
These folder locations are hidden by default, so you may need to show all files and folders in order to
find them (My Computer --> Tools --> Folder Options --> View tab --> Show all files and folders).
3.2 Updating The Software

Software Updates

As new releases become available, you may upgrade the Home Manager software as follows:

1. Make a backup of the database for safety (File --> Backup).
2. Use the menu option Help --> Check for updates, and follow the installation prompts, or if you are

© 2024 Kaizen Software Solutions
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unable to connect to our update server, close Home Manager, and then install the current version of
the software from our website. This will not overwrite your existing database.

3.3 Technical Details
System Requirements

The initial installation will require 15mb.

The normal rate of growth of the database file without file attachments is 1 MB per 1000 records.
Pictures can be added at a rate of about 6 MB per 100 records.

If file attachments are added to records, the database will grow in size based on the size of the
attachments.

PC:

e Minimum CPU: 1 Ghz

e Operating System: Windows 10 or higher.

o Notes: The setup process will download and install .NET 8.0 if it is not already installed.

Home Manager Database

Home Manager stores all of the data and pictures in a single database file.

Home Manager Database files have the file extension “.hdb".

Home Manager backup files are compressed to save space and have the file extension “.hbk".
Home Manager uses the open source Firebird database for data storage.

The local database is stored at the following location:

Windows Vista: C:\ProgramData\HomeManager.hdb

4 How To (Steps)

Add a new inventory item

1. Click the "New Inventory Item" button on the General tab.
2. Fill in the item details.
3. Click the Save button on the General tab.

Notes:

¢ Select the Category and Location for the item from the drop-down list. You may add, edit, and remove
Categories and Locations from the list by clicking on the button next to the drop down field.

¢ You may select the Purchase date by clicking on the down arrow and using the calendar, or you may
type it directly in to the field.

e Currency symbols are not required. The reports will display the currency symbol set in your Windows
Regional Options.

Find previously entered inventory items

Select the Location or Category on the left side of the Inventory window, and then look for your item in

the Inventory List view, or use the search feature to search across all Locations and Categories at once.
Items matching your search criteria will appear in the Inventory List view. The search function will look

for inventory items with words on the General tab matching your search criteria.

© 2024 Kaizen Software Solutions
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Add a new Maintenance/Repair item

1. Select the Maintenance/Repair History tab at the bottom of the Inventory screen.
2. Click on the "Add Repair" button.

3. Enter the repair details in the repair item form.

4, Click the Ok button to save your changes.

5. The repair item will be added to the list.

Add the Warranty/Insurance Information

Select the inventory item in the list view, and then select the Warranty/Insurance tab.
Fill in the Manufacturer and Warranty information, and then click the "Save" button.

Manage Categories and Locations

1. Click the button to the right of the Category/Location drop-down field.
2. Select the Category/Location in the list and then click "Edit" or "Delete", or click the "New" button to
add a new category/location.

Add individual pictures

1. Select the inventory item in the list view.

2. Click the "Add" button near the bottom of the picture box area.
3. Select your picture, and then click the Ok button.

4. You may add multiple pictures to an item by repeating steps 2-3.

Note: you may also drag and drop a picture file from Windows File Explorer to the picture box.

Add pictures in bulk

If you already have a lot of digital pictures of the items in your house, you can create new inventory
records for them automatically by dragging an entire group of pictures on the inventory list view.

1. Select multiple pictures in the Windows File Explorer.
2. Drag the pictures to the Inventory List View. This will create a new inventory item for each picture.
3. Update the item data for each as needed.

How To Buy

You may purchase Home Manager online worldwide with any major credit card.

As soon as your transaction is complete, your license key will be emailed to you, and you can enter the
license key to continue working where you left off.

Purchasing Links

Direct Order:

http://www.kzsoftware.com/purchase/homemanager/

Additional Purchasing Options
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How To Buy

http://www.kzsoftware.com/purchase/options.htm

6 Getting More Help

21

Technical Support and Customer Service is also available via email. You may contact us for additional

help using the links below:

Contact Us

For Technical Support:
http://www.kzsoftware.com/support/index.htm

For Customer Service:
http: //www.kzsoftware.com/contact/index.htm

Reach us by mail at:
Kaizen Software Solutions, LLC
39962 Cedar Blvd. Ste. 323
Newark, CA 94560-5326
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